
User Tutorial: Welcome

The User Tutorial consists of a series of exercises to help you 
quickly learn basic DocuShare features. To take advantage of 
the exercises, you should have DocuShare running in an open 
browser window.

Module 1: Interface features

Module 2: Creating accounts

Module 3: Adding content to your site

Module 4: Working with documents

Module 5: Setting up My DocuShare

Module 6: Using access permissions

Module 7: Searching for objects

Module 8: Using collaborative workspaces



Module 1: Interface features

Key interface features

The intuitive interface of DocuShare enables users at any level 
to learn to use its features quickly. Key features include:

• Icons representing different types of content

• Action commands display task pages in one click

• Task pages with menus and options that are easy to use

• A navigation bar and footer on each page for quick 
access to product features

• A personal home page (“My DocuShare”)



Module 1: Interface features

Navigating your site

DocuShare provides the navigation features that enable you to 
easily move around your site and find what you need.

Navigation bar—Located at the top of each page, the 
navigation bar provides links to frequently used pages.

Breadcrumbs—Below the navigation bar, the breadcrumbs 
provide a hierarchical path back to the home page from your 
current location.

Page footer—Located at the bottom of each page, the footer 
includes additional useful links.

Search —Located at the top of each page, the search box 
enables you to find the content you need quickly. There is the 
capability of performing an advanced search using date ranges 
and other filters.



Module 1: Interface features

Personal home page

DocuShare provides a personal home page, called My 
DocuShare, that you use to manage both private and site 
content. Your administrator may set My DocuShare to be the 
first page users see after logging into DocuShare. A link is 
always available on the navigation bar.

My DocuShare includes a personal collection in which you add 
private content, shortcuts to your favorite objects, a list of the 
groups you belong to, and more.



Module 2: Creating accounts

Introduction

Your administrator determines who can access your site and 
create user and group accounts. As a guest (one who can 
access the site and view unrestricted content), you may be able 
to create a user account depending on the policy that is enabled. 
When individual users are able to create accounts, users can 
create accounts with their level of access or lower. 

If site access and account creation are restricted, an 
administrator or someone with a user account will need to 
create a user account for you. To add objects and edit content, 
you must have a user account with DocuShare or CPX access. 

The exercises in this module show you how to create a user 
account, create a group, log out and then log back in.



Module 2: Creating accounts

User levels

DocuShare enables sites to easily manage access to content and 
capabilities through user levels. This feature allows different 
types of users to access the same content, but only the 
functions needed for their job. One of the following user levels 
can be assigned to an account:

Read-Only—Allows the user to view content and manage 
personal content on My DocuShare.

DocuShare—All of the capability of a Read-Only account, plus 
those with the DocuShare user level can access all content 
management functions.

CPX—All of the capability of a DocuShare account, plus 
collaboration and process management features.



Module 2: Creating accounts

Creating a user account

You will begin by creating a user account for yourself. You can 
create a user account if your site allows a guest or logged-in 
user to do so.

1. On the DocuShare footer, click Users & Groups.

The Users and Groups Registry page appears. From this 
page you can create, list, and find users and groups.

2. Click the Add User link.



Module 2: Creating accounts

Creating a user account

3. On the Add User page, enter the following information:

Username: The name you want to use to log into 
DocuShare.

Password and Password Confirm: The password you 
want to use to log into DocuShare. Be sure to adhere to 
the rules listed in the Password rules box. Also, your 
password is case-sensitive.

Domain: The organization or entity to which you belong.

User Level: The level of access to site content and 
functions.

Last Name: Your last name.

Email Address: Your email address.



Module 2: Creating accounts

Creating a user account

4. Enter any optional information. You can click a field name 
to get more information.

5. Click the Apply button.

The Properties page for your user account appears, and 
your username displays in the upper right corner of the 
window indicating that you are logged in.



Module 2: Creating accounts

Creating a group

By default, a logged-in user can create a group account. Groups 
enable you to assign access permissions to a group instead of to 
individual users.

1. On the footer, click Users & Groups.

2. On the Users & Groups Registry page, click the Add 
Group link.

3. In the Title field, enter a name for the group.

4. Select the correct Domain and Spam Control settings.

5. Enter any optional information. You can click a field name 
to get more information.

6. Click Apply.



Module 2: Creating accounts

Creating a group

7. In the Search field, enter part of the name of a user on 
your site and click Go.

Note: You can also display your favorite users (module 5 
explains how to add favorites).

8. In the Possible Users/Groups field, select the 
username and click the Add button.

9. Click the Update button.

The group members display on the Members page. When 
you want to add and remove group members click 
Change Membership.



Module 2: Creating accounts

Logging in and out

After creating your account in the first exercise, you were 
logged into DocuShare.

1. To log out, click the Logout link on the navigation bar.

2. To log into DocuShare, enter your username and 
password in the Login area.

Remember, your password is case-sensitive.

3. If the Retain login for future checkbox appears, click it 
if you want to remain logged into DocuShare after you 
close and reopen your browser.

4. Click Login.



Module 3: Adding content to your site

Introduction

You can add a variety of objects to your site, such as 
documents, calendars, wikis, weblogs, and URLs as well as any 
custom objects your administrator creates. Provided you have 
the appropriate write permission to the container, you can add 
objects to it.

The exercises in this module show you how to add a collection, a 
document, and a notification.



Module 3: Adding content to your site

Adding a collection

You store and manage objects in repositories called collections. 
As a logged-in user, you can add a collection to your site.

1. Click one of the top level collections to open it. On My 
DocuShare, the top level collections appear in the Site 
Home portlet.

2. From the Add menu, select Collection.

The Add Collection page appears.

3. In the Title field, enter a name for the collection.

4. Enter any optional information.

5. Click Apply.

The collection is added to DocuShare.



Module 3: Adding content to your site

Adding a document

You can drag-and-drop documents to add them to collections.

1. Click the title of your collection to open it.

2. In your file system, navigate to the document you would 
like to add. Drag it to the open collection. Two 
rectangular areas display in the window.

• If you would like to instantly upload the document 
without changing its properties, drop the document 
onto the area on the left.

• If you would like to change the document properties 
before you upload, drop the document onto the area 
on the right. The Enter Required Properties 
window displays. Here you can give the document a 
title and enter some optional properties. Once you 
are done, click the Add button.



Module 3: Adding content to your site

Adding a notification

A notification allows you to receive an email message when a 
change occurs to a DocuShare object. You can add a notification 
for any object on your site. In this exercise, you will add a 
notification for your collection to receive an email message each 
time an object is added to it.

1. Click the ellipsis that appears to the right of your 
collection's title to display the More Actions menu.

2. Select Notifications .

3. On the Notifications page, click Create a New 
Notification.



Module 3: Adding content to your site

Adding a notification

4. The Period menu specifies when DocuShare sends the 
email message. Keep it set to Immediate.

5. Click Show Advanced Options.

6. From the Events of Interest menu, select Something 
added.



Module 3: Adding content to your site

Adding a notification

7. Click Apply.

A description of the notification appears on the 
Notifications page. From this page, you can change the 
notification as well as delete it.

8. Go to your collection and add another document to it.

In a few moments, you will receive an email notification.



Module 4: Working with documents

Introduction

You can easily browse the content of documents and collaborate 
with other users in creating documents. For document 
management, DocuShare provides document check out and 
version control features. Version control lets you maintain a 
specified number of document versions and a history of 
changes.

The exercises in this module show you how to browse and edit 
documents.



Module 4: Working with documents

Browsing a document

1. Navigate to and open your collection.

2. Open one of your documents by clicking its title.

3. If a window appears, choose the option to open the 
document.

4. To return to the collection, click the browser's Back 
button or close the document's window.

Note: Your browser's configuration determines whether a 
document opens in the browser window or in a separate 
application window.



Module 4: Working with documents

Browsing a document

DocuShare provides conversion features that let you view 
supported document types in different formats.

5. Click the View in HTML  command from the More 
Actions menu (click the ellipsis to display the menu).

6. To return to the collection, click the browser's Back 
button.

7. Click the View in PDF  command from the More 
Actions menu (this action is available if your site is set 
up to use the feature).



Module 4: Working with documents

Editing a document

When you check out a document for editing, DocuShare locks it 
to prevent other users from editing the document at the same 
time.

1. From the More Actions menu, click the document’s 
Check Out  command.

2. In the window that appears, choose the option to open 
the document.

3. Make some changes to the document.



Module 4: Working with documents

Editing a document

4. Do one of the following:

• If the document opened in the browser, click the 
Back button. Click Yes to save your edits.

• If the document opened in its native editor, select 
Save As from the File menu.

5. In the Save As window, save the document to a location 
on your local drive. Do not change the name of the 
document. Close the document.



Module 4: Working with documents

Editing a document

6. From the More Actions menu, click the document’s 
Upload a New Version  icon.

7. On the Add Version page, click the Browse button.

8. Navigate to the location on your local drive in which you 
saved the edited document, select it, and click Open.

The name of the document appears in the Filename 
field.



Module 4: Working with documents

Editing a document

9. In the Version Comments field, enter a note about the 
changes you made.

Keep Unlock Document set to Yes.

10. Click Apply.

The View Properties page appears.

11. Click the Version History link to see both versions of 
your document.



Module 5: Setting up My DocuShare

Introduction

My DocuShare provides a single page from which you can easily 
manage personal content (other users cannot access the page). 
Depending on how your site is set up, My DocuShare includes 
some or all of the following portlets:

• Personal Collection

• Workspaces

• Favorite Calendars

• Personal Trashcan

• Favorites

• My Groups

• Tasks

• Site Home (top level site contents)

The exercises in this module show you how to add favorites to 
My DocuShare and add objects to your personal collection.



Module 5: Setting up My DocuShare

Adding favorites to My DocuShare

You add favorites to My DocuShare to keep links to your 
frequently used objects in one location.

1. Navigate to and open your collection.

2. Select an object by clicking to the left of the object icon.

3. From the Edit Selected menu, click Add to Favorites.



Module 5: Setting up My DocuShare

Adding favorites to My DocuShare

4. In the confirmation window, click Confirm.

You return to your collection.

5. On the navigation bar, click My DocuShare.

A link to your document appears under Favorites.

6. Click the Favorites heading to display favorites in a 
collection listing. In this view, you can select and edit 
favorites, including remove favorites, using the Edit 
Selected menu.

Note: Another way to add an object to your favorites is by 
clicking the star that appears under Actions.



Module 5: Setting up My DocuShare

Using the Personal Collection

The Personal Collection on My DocuShare is a private collection 
to which other users do not have access. You can add any 
private objects to this collection.

1. On the navigation bar, click My DocuShare.

2. Click Personal Collection to open the collection.

3. Use the Add menu to add an object to the collection.



Module 6: Using access permissions

To control who can view, change, and delete site objects, 
DocuShare provides permissions. Depending on how your site is 
set up, DocuShare provides either three or six types of 
permissions that you can assign to the users and groups in an 
object’s access list. You are the owner of any object that you 
add to your site, which allows you to assign and change the 
object’s permissions.

The exercises in this module explain how to add users to an 
access list, change permissions, and change an object's owner.



Module 6: Using access permissions

Changing an object's permissions

1. Open your collection.

2. Click a document's Permissions  command from 
the More Actions menu.

The Permissions page appears, which shows the 
document's access list. As the document's owner, your 
name appears in the access list with all permissions.

3. To add users and groups to the access list, click the 
Change Access List button.

The Change Access List page appears.



Module 6: Using access permissions

Changing an object's permissions

4. For Show, select the Groups radio button.

5. In the Search field, enter part of the name of the group 
you created in module 2 and click Go.

6. In the Possible Users/Groups field, select the group 
name and click the Add button to add the group to the 
access list.

7. Click the Update Access List button.

The Permissions page appears, displaying the group in 
the access list.



Module 6: Using access permissions

Changing an object's permissions

8. In the Search Available To field, choose who can view 
the object in a search:

• Anyone allows guests and all users to view the 
object.

• Access List Only allows only those accounts in the 
object’s access list that have at least read permission 
to view the object.

9. In the Access List, select the permissions you want for 
the group.

For a description of each permission, click the Access 
List field.

10. Click Apply.



Module 6: Using access permissions

Changing an object's owner

As the owner of an object, you can assign ownership to another 
user. An object's owner is shown when viewing the contents of 
collections, search results, and the object's properties.

1. On the Permissions page, click the Change Owner 
button.

The Change Owner page appears.



Module 6: Using access permissions

Changing an object's owner

2. Use the Search field to find a user on your site.

3. Select the username from the New Owner field.

4. Click the Update Owner button.

The new owner's name appears on the Permissions page 
with full permissions. You remain in the access list.



Module 7: Searching for objects

Introduction

DocuShare search features enable you to quickly find objects 
and content on your site. You can run simple word searches as 
well as advanced searches, should you need to narrow the 
results of a search.

The exercises in this module show you how to run a word 
search, run an advanced search, and save a search query.



Module 7: Searching for objects

Running a word search

Using the search area on the navigation bar, you can quickly 
search for objects and content.

1. In the Search field, enter a word from the title of the 
collection you added.

2. Click Search.

The search results display.

Note: When running a word search, you can click the small 
gear next to the Search field to display the Extended Search 
options.



Module 7: Searching for objects

Running an advanced search

On the Advanced Search page, you can combine search terms 
and search for specific objects and document types.

1. On the navigation bar, click Advanced.

2. Under Search Text Contained In, enter a word from 
your document's title in the box after contains.

3. Click + add search term.

4. In the box after contains, enter your username.

5. From the menu after In, select Owner.



Module 7: Searching for objects

Running an advanced search

6. Under Search Within, select The entire site.

7. In the Sort Results field, select By Title to display the 
results in alphabetical order.

8. Under Object Types to Search, select Limit search to 
selected object types and then select Document.

9. Click Search.

The search results will display.



Module 7: Searching for objects

Saving a search

On the Search Results page, you can save the query you used to 
run the search.

1. From the Add menu, select SavedQuery.

2. In the Title field, enter a name for the saved query.

3. To make the query easier to find, enter a summary and 
description of the query. You can also review the query 
settings and make any changes that may improve your 
results in the future.

4. At the bottom of the page, click Save Search.

The Properties page for the saved query appears, so you 
can add it to a collection.



Module 7: Searching for objects

Saving a search

5. In the Search field, enter a word from the title of your 
collection and click Go.

6. In the Possible Locations field, select your collection 
and click the Add button. Your collection appears in the 
Selected Locations field.

7. Click the Update Locations button.



Module 7: Searching for objects

Saving a search

8. In the Current Locations field, click your collection.

You can see your saved query in the collection.

9. Click the saved query to run the search again.



Module 8: Using collaborative workspaces

Introduction

Note: This feature is only available for those with CPX user 
level access.

A workspace provides a shared area for project and team 
collaboration. From a single page within DocuShare you and 
other workspace members can gather and manage shared 
content, access collaboration tools to facilitate your work, and 
communicate with each other.

The exercises in this module show you how to add a workspace 
and change its members.



Module 8: Using collaborative workspaces

Adding a workspace

You can add a workspace to another workspace on your site, or 
you can add a workspace from the workspaces portlet on My 
DocuShare. In this exercise, you will add a workspace from My 
DocuShare.

1. On the navigation bar, click My DocuShare.

2. In the Workspaces portlet, click Add a Workspace.

The Add a New Workspace wizard appears.

3. Select the Team Project Workspace and click Next.



Module 8: Using collaborative workspaces

Adding a workspace

4. In the Title field, enter a name for the workspace.

5. Click Done.

The workspace home page appears. It includes four 
portlets: content, calendar, shortcuts, and membership. 
A collection for online meeting URLs, a calendar, and a 
top level workspace collection are added to the content 
portlet. In addition, a membership group is created for 
the workspace, with you as its initial member.
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Adding workspace members

As the user who added the workspace, you can add other users 
and groups to the membership group.

1. On the workspace home page, click the Membership 
portlet title.

2. On the Membership page, click Change Membership.

3. Search for a specific user on your site.

4. In the Possible Users/Groups field, select the user and 
click Add.

If you like, you can search for and add more users.
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Adding workspace members

5. Click Update.

The Properties page for the group appears and lists the 
members. Each member is assigned full read and write 
permissions to the workspace. You can assign manage 
permission to individual group members on this page, or 
you can assign manage permission to the entire group.

6. To assign manage permission to the group, go to My 
DocuShare.

7. In the workspaces portlet, locate your workspace.

8. Click the Properties command  from the More 
Actions menu.
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Adding workspace members

9. Click the Permissions link.

10. In the access list, click the manage checkbox for the 
group.

11. Click Apply.



Where to go next

There are many DocuShare features that are not covered in this 
tutorial. The DocuShare User Guide fully describes all of 
DocuShare's capabilities. On the footer, click Help to display the 
Help Desk. Print the guide and review its contents.

Information about additional DocuShare training is available on 
the DocuShare web site.

http://docushare.xerox.com/resource/resource_training.html

